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Overview of Reporting System
QuantOffice has powerful and rich functionality for reports creation. Its report generation process
creates reports containing strategy execution statistics. You can use the QuantOffice reporting to:
•

Document strategy execution.

•

Analyze and visualize strategy execution.

•

Export reports to Microsoft Excel, Adobe Acrobat PDF and Comma Separated Values
documents.

•

Keep reports in persistence repository for later review.

Predefined Reports
QuantOffice supports a set of predefined standard reports, which are implemented with the help of
Report Engine. These are ten standard reports (eight non-consolidated and two consolidated),
which are briefly described in the table below:
Standard Non-Consolidated Reports
Report
Trades report

Description
Summarizes related events surrounding the trade records, including profit
from each trade, etc.

Orders report

Presents detailed order information.

Executions report

Itemizes each execution contained in a trade including time and exchange
the execution was performed at and other related information.

Performance report

Includes performance statistics for each distinct experiment.

By Period report

Summarizes information about trade results for the designated time period in
graphical and tabular format.

By Instrument report

Presents performance statistics summarized by financial instruments.
Separate report is created for each experiment.

Drawdown report

Describes drawdown statistics.

Allocation report

Analyzes the level of diversification within a portfolio, by showing allocation to
each symbol (or industry).

Standard Consolidated Reports
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Report

Description

Performance report

Presents performance statistics for all completed experiments, sorted by

(consolidated)

Long, Short and All trades.

By Instrument report

Presents cumulative performance and risk management statistics for each

(consolidated)

instrument. Contains information for all completed experiments.

These reports are described in the Built-in Reports and Report Engine section of this document.
You can customize the built-in reports fitting them to your needs. For details on working with report
definition in the strategy code see the Customizations in Using Standard Reports section.

Report Engine
As it was said above Report Engine is a vitally necessary component for standard reports creation.
It collects and processes strategy’s execution statistics. Which is later presented in built-in standard
reports.
Additionally, the statistics can be accessed from the strategy code.

Custom Reports
You can create custom reports, which definition is all at your fingertips. These reports are
implemented with the help of log methods that predefines continuous logging of their information on
the screen during the strategy execution. You entirely define which data and in which columns of
these reports to display.

Viewing Reports
No matter which report you have created you are welcome to view and study it with Report
Explorer. The provided controls and possibilities can slightly vary from report to report. However,
they stay powerful, user-friendly and oriented on a wide range of analyzing needs.

Supported Report Formats
When the report generation process creates a report, it generates data in memory or writes data to
tick database format on local disk.
Next, you can convert reports in Report Explorer to one of these user-specified report formats:
•

Microsoft® Excel (.xls)

•

Adobe® Acrobat® PDF (.pdf)
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•

Comma Separated Values (*.csv)

Built-in Reports and Report Engine
As it was said above, QuantOffice suggests its users a number of predefined reports.
These reports are implemented via the provided Report Engine component and have predefined
structure and content. The user is responsible only for correct application of Report Engine
component and such reports in his/her strategy.
In addition, the Report Engine component can be used to collect statistics on strategy execution.
Report Engine component as well as all the required standard reports can be added into a strategy
via user-friendly interface commands (the Add Component command).
If you prefer to add necessary code manually you can find required instructions in the Code Added
for Report Engine and Reports section.
You can also refer to this section for description of changes made in strategy code after addition of
the Report Engine component via the Add Component command.
If necessary, you can noticeably modify and improve standard reports in the strategy code (these
features are intended for advanced users).

Including Report Engine and Predefined Reports into Strategy
Adding the Report Engine component and predefined reports into your strategy is as easy as
choosing appropriate command and filling a dialog box. As a result, all the required generated code
for the Report Engine and for the selected predefined reports you chose is inserted into your
strategy files ready for modification and use.
To add Report Engine into the strategy code, perform the following operations:
•

Choose Add Component -> Report Engine… command from the Tools main menu of the
Configuration tab of Strategy Designer or click New… in the Variables and Indicators
group and choose Component -> Report Engine… command.

The Report Engine dialog appears:
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Figure 1. The Report Engine dialog

•

In the Variable Name box specify a name for the variable providing access to the Report
Engine.

•

In the General Properties section specify initial values for the Initial Capital, Interest on
Cash and Minimum Acceptable Return properties. If you want to generate an input
parameter for a property, check the box in line with the parameter and specify a name for
the input parameter in the provided box (the typed name must be a valid identifier in C#
language).

Input parameters are created for the properties to have ability to change the properties on the fly
when starting strategy execution without a need to edit and recompile the strategy code.
If you define an input parameter, it will appear in the Input Parameters dialog box when the
strategy is started using the Run or the Quick Run command in QuantOffice for the first time. The
parameters

will

be

available

for

modification

in

the

dialog.

Next time the strategy is started the Input Parameters dialog will show the saved parameters from
the previous strategy run instead of default values defined in the strategy code.
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•

In the Available Reports section check the reports you want to be generated.

For the Performance and ByInstrument you can also check the Consolidated boxes to generate
appropriate consolidated reports.
•

Check Generate Input Parameter to enable/disable Component box and specify a name
for the input parameter in the provided edit box if you want to handle report creation via the
input parameter.

When all the necessary specifications in the Report Engine dialog are made
•

Click OK.

Adding Report Engine component into the strategy makes modifications in the PortfolioExecutor.cs
file. As the result, the PortfolioExecutor.cs file with the inserted code is opened in separate tab.
Note that for successful work of Report Engine QuantOffice requires Order Processor component
which can be easily added via Add Component -> Order Processor… command (for details see
the Strategy Designer document).

Report Engine Properties
Report Engine is a required component for standard reports creation and can be additionally used
to collect statistics on strategy execution.
Brief descriptions of Report Engine properties are provided below:
Field

Description

InitialCapital

Initial Capital Amount.

RiskFreeRate

Assumed risk-free interest rate obtained by investing in financial instruments
with zero risk.

Mar

Minimum Acceptable Return (used in Sortino ratio calculation).

FundingCurrency

Trading funding currency. If trading is performed in several currencies and
conversion is used, the funding currency is the currency into which the other
ones are converted. In such cases reports will be available for each involved
currency and for the funding currency.

FastTradeStatsMode

With the only Performance Report enabled, this option speeds up the report
generation by eliminating the collection of trade statistics and calculating
performance metrics on-the-fly when set to true.*

FastPositionStatsMode

With the only Performance Report enabled, this option speeds up the report
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generation by eliminating the collection of position statistics and calculating
performance metrics on-the-fly when set to true.*
DayCloseTime

Indicating exchange close time when running across exchanges in different
time zones.

TotalReinvestMode

Indicating whether reinvestment of realized profit is involved into calculation
of risk return statistics.
Total Reinvest Mode has effect to calculating the following metrics:
•

SharpeRatio

•

SortinoRatio

•

AnnualizedVolatility

•

UPI

•

OptimalF

In the Byperiod report the return(%) is calculated as follow:
Total

Reinvest

Mode

==

true:

(Current

period’s

PnL

–

Previous

period’s PnL) / (Initial Capital + previous period’s PnL)
Total Reinvest Mode == false: (Current period’s PnL – Previous
period’s) / Initial Capital

* Enabling Trades, Orders or Executions reports doesn’t influence the work of the
FastTradeStatsMode and FastPositionStatsMode properties and performed optimization. However,
if any other reports are included in addition to Performance Report the optimization will not work.
If you are going to use the optimization, it is recommended to use both optimizations to feel
essential improvement in the performance.

Trades Report
The Trades Report contains the entire list of trades taken by the strategy during execution.
Trade is not an elementary trade operation (Buy or Sell). Trade is a buy-sell pair (Long trade) or
sell-buy pair (Short trade). Type of a trade (L or S) is defined by sign of sharesQtty. Negative sign
means that it is a Short trade. Positive sign means it is a Long trade. Opening part of the trade
could be an aggregate of more than one elementary transaction: B{B}S or S{S}B. Trade is a pair of
executions (not orders), but 2 trades can be generated by 3 executions, for example:
1. Suppose we have a zero position at the beginning of trading for this stock. We buy 100
shares (one execution), and then sell 100 (one execution) - we have 1 long trade with size
100.
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2. We buy 100 (one execution), then sell 50 (one execution), after that we sell 50 (one
execution) - we have 2 long trades with sizes 50.
The figure below presents an example of a Trades Report:

Figure 2. Trades Report

The next table briefly describes Trades Report columns:
Column

Description

#

Trade Record Number.

Instrument

Instrument Ticker.

Type

Position type: Long or Short.

Size

Size of the trade or trading volume.

Entry Time

Opening position time.

Entry Price

Position average entry price.

Formula or Notes

Calculated as weighted average (see the
example next to the table).

Exit Time

Closing position time.
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Exit Price

Instrument price at closing position
time (execution price).

Net Profit

Trade Profit/Loss (PnL).

(Exit Price - Entry Price) * Size

Cumulative

Sum of Net Profit till and including

Cumulative Profit(N) = SUM(Net Profit(i)),

Profit

this trade.

where i – trade numbers less or equal to N

% Change

Trade effectiveness in percent.

Exit Price / Entry Price * 100%

WinOrLoss

Trade result in qualitative manner.

Winning if trade Net Profit > 0, Losing if Net
Profit =< 0.

Entry Signal

Order side when opening position.
Buy – for Long position, Sell – for
Short position.

Entry Reason

Rule that initiated the order to open
position.

Exit Signal

Order side when closing position.
Buy – for Long position, Sell – for
Short position.

Exit Reason

Rule that initiated the order to close
position.

MAE %

in

MAE/(Entry Price * Size)

Maximum Favorable Excursion in

MFE/(Entry Price * Size)

Maximum

Adverse

Excursion

percent.
MFE %

percent.
MAE

Maximum Adverse Excursion is the
maximum loss that the trade had
before the trade closed.

MFE

Maximum Favorable Excursion is the
maximum profit of the trade before
the trade closed.

Currency

Trade currency code.

Conversion

Ratio of the trade currency to the

Is displayed by default when Conversion Engine

Rate

funding currency.

was enabled for report generation.

Net Profit Fund

Trade Profit/Loss in the funding

Is displayed by default when Conversion Engine

currency.

was enabled for report generation.
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Cumulative

Sum of Net Profit till and including

Is displayed by default when Conversion Engine

Profit Fund

this trade in the funding currency.

was enabled for report generation.

Portfolio

Portfolio Name.

Time in Trade

Trade duration in the dd.hh/mm/ss

Exit Time – Entry Time

format.
Commission

Trade

commission

(consolidated

commission for all trade orders).
Commission

Trade

commission

(consolidated

Fund

commission for all trade orders) in

Is displayed by default when Conversion Engine
was enabled for report generation.

the funding currency.

Using the Setup Columns command you can add columns for strategy parameters’ values into the
report.
In the Trades Report the Entry Time is the time when either long or short position was opened.
Once the open position has been closed fully or partially, we have a new trade in the trade report.
In other words, each “trade” has some Realized PnL.
Let’s consider an example:
A strategy buys shares of X company for three times:
100 by 10.00 $ at 11:00:00
200 by 10.10 $ at 11:05:00
200 by 10.15 $ at 11:10:00
At this time, we are keeping a long position (cumulatively) for 500 shares of X with average buy
price: = (10.00*100 + 10.10*200 + 10.15*200) / 500 = 10.10 $
Then the strategy sells 2 times by 300 shares:
300 by 10.15 at 11:15:00
200 by 10.20 at 11:20:00
In the trade report we will see the following two trades:
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Type

EntryTime

EntryPrice

Qtty

ExitTime

ExitPrice

Net Profit

Long

11:00:00

10.10

300

11:15:00

10.15

15

Long

11:00:00

10.10

200

11:20:00

10.20

20

Orders Report
The Orders Report contains the entire list of orders taken by the strategy during execution. An
example of Orders Report is shown below:

Figure 3. Orders Report

The next table briefly describes Orders Report columns:
Column

Description

#

Order Record Number.

Instrument

Instrument Ticker.

Side

Order side: either Buy or Sell.

Order

Order type, such as Market, Stop or Limit.
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Size

Number of instrument units for the purchase or sale.

Limit

Limit order specific price.

Stop

Stop order specific price.

Status

Order Status.

Time

Order Execution Time.

Execution Size

Order Execution Size.

Price

Price at which the order was executed.

Exchange

Exchange the order is executed on.

Account

Account the order is executed for.

Remaining

Order Remaining Size

Time In Force

How long an order will remain active before it is executed or expired.

ID

Order unique numeric identifier.

Portfolio

Each order can optionally belong to a user specified portfolio. This is the portfolio name.

Reason

Rule that initiated the order.

Cancel/Reject

Reason of order cancel/reject.

Reason
Commission

The commission charges incurred on the order.

Broker ID

Identifier of the broker the order was sent to. If the ID was not specified during sending
the order, the default broker configured for Strategy Server is used.

Using the Setup Columns command, you can add columns for strategy parameters’ values into
the report.

Executions Report
The Executions Report contains the entire list of executions taken by the strategy during its work.
An example of Executions Report is shown below:
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Figure 4. Executions Report

The next table briefly describes Executions Report columns:
Column

Description

#

Execution Record Number.

Action

Execution action. BOT – for Buy position, SLD – for Sell.

Size

Number of instruments for the purchase or sale.

Instrument

Instrument Ticker.

Price

Execution Price.

Currency

Execution currency code.

Exchange

Execution Exchange.

Account

Account the order is executed for.

Time

Time when execution occurs in exchange time zone if time is set to be converted to
exchange time zone (ExecutionReport.TimeZone == TimeZoneType.Exchange ). In all the
other cases the same as Local time – time when execution occurs in QuantOffice time
zone.
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ID

Execution unique ID.

Commission

Execution commission.

Portfolio

Portfolio Name.

Time Local

Time when execution occurs in QuantOffice time zone.

Using the Setup Columns command, you can add columns for strategy parameters’ values into
the report.

Performance Report
The Performance Report contains the performance metrics of strategy execution. An example of
Performance Report is shown below:
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Figure 5. Performance Report

You can observe performance statistics in a table view clicking the Switch to table view button:

Figure 6. Table View of Performance Report

Table view is a sort of analysis view which allows grouping, sorting and filtering. It also contains
options for setting up columns and drawing diagrams.
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The next table briefly describes Performance Report columns:
Column

Description

Formula
Total Profit - Total Loss

Net Profit/Loss

Strategy Total Profit or Loss.

Total Profit

Sum of profits of all winning strategy
trades.

Total Loss

Sum of losses of all losing strategy
trades.

Cumulated Profit %

Max Drawdown

Value of profit or loss relatively to

Net Profit/Loss / Initial Capital *

strategy initial capital in percent.

100%

Maximum

of

the

peak-to-trough

declines in cumulative profit during a
strategy execution period.
Max Drawdown %

The

same

as

Max

Drawdown

expressed in the percentage between
the peak and the trough.
Max Drawdown Time

Time and date when Max Drawdown
occurred.

Return/Drawdown

Used

to

measure

return

vs.

Ratio

drawdown risk.

Drawdown Days %

Number of days in drawdown relative

Net Profit/Loss / Max Drawdown

to overall strategy execution time.
Max Drawdown

Duration (in days) of Max Drawdown.

MAX (Continuous Drawdown Duration)

Compound Annual Growth Rate - the

(End Capital / Initial Capital) ^ (1 /

year-over-year growth rate of an

(Trading Days / Annualized Base)) – 1

Duration

CAGR

investment over a strategy execution
time.
Sharpe Ratio

Annualized Volatility

* Used to measure risk-adjusted

(CAGR – Risk Free Rate) / Annualized

performance.

Volatility

* Measure of the dispersion of

STDEV(Return%) * SQRT(Annualized Base)

returns.
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Sortino Ratio

UPI

* Ratio of differentiate between good

CAGR – Min Acceptable Return) /

and bad volatility in the Sharpe ratio.

Annualized Down Side DeviationR%

* Ulcer Performance Index. Measure

(CAGR – Risk Free Rate) / Annualized

of risk adjusted return that takes into

Down Side Deviation

consideration downside volatility.

Information Ratio

Optimal f

* Measure of the risk-adjusted return

AVERAGE(Return) * SQRT(Annualized Base)

of a financial security.

/ STDEV(Return)

* Optimal amount of risk that should

(CAGR – Risk Free Rate) / ((Annualized

be taken on for the highest gains

Volatility/100) ^ 2)

compared to risk of ruin.

Historical VaR 95%

Historical VAR/CVAR statistics are

The array of returns is sorted by ascending,

1D/ Historical CVaR

calculated using strategy daily return

then the VAR95 is calculates as a 0.05

95% 1D

distribution got from back-testing.

quantile of this array.

VAR95 is left tail 5% value of return

For CVAR95 get the least 5% of values of

distribution.

the array and calculate its average.

CVAR95 is expected value of that 5%
left tail.
Theoretical VaR 95%

Theoretical VAR/CVAR metrics are

VaR ∝ (X) = FX−1 (α) = μ + k(α)σ

1D / Theoretical

taken from assumption of Normal

where

CVaR 95% 1D

distribution law with avg. hist. daily

k(α) = √2erf −1 (2α − 1),

return and avg. std. deviation of hist.

and

daily returns as shift/scale parameter

z
2
2
erf(z) = ( ) ∫ e−t dt
π
√
0

estimates.

Therefore, we calculate the mean μ and std
deviation σ of historical daily returns, and
calculate theoretical VaR95 by this formula,
where α=0.05 (because we use returns, not
losses).
For theoretical CVaR the formula is the
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following, α=0.05:
CVaR α (X) = E[X|X ≤ VaR α (X)] = μ − k1 (α)σ,
where
k1 (α) = (√2π exp(erf −1 (2α − 1))2 (1 − α))

−1

and
z
2
2
erf(z) = ( ) ∫ e−t dt
√π 0

All Trades #

Total number of trades.

Profitable Trades

Ratio of winning trades number to

Ratio

number of all trades.

Winning Trades #

Number of winning trades (Trade PnL

Winning Trades # / All Trades #

> 0).
Losing Trades #

Number of losing trades (Trade PnL
< 0).

Average Trade

Net Profit/Loss / All Trades #

Average profit experienced from all
trades.

Average Winning

Average profit experienced from all

Trade

winning trades.

Average Losing Trade

Average loss experienced from all

Total Profit / Winning Trades #

Total Loss / Losing Trades #

losing trades.
Avg.Win/Avg.Loss

Ratio

that

can

be

used

as

a

Ratio

performance measurement of your

Average Winning Trade / Average Losing
Trade

strategy. A value greater than 1
signifies that the strategy wins more
than loses. A value less than 1
signifies that the strategy loses more
than wins.
Average Profit per

Net Profit/Loss /

Share

Trades Size (sum of sizes of all the trades)

Max Conseq. Winners

Maximum number of continuous
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winning trades.
Max Conseq. Loosers

Maximum number of continuous
losing trades.

Currency

The funding currency if it was

Is displayed by default if Conversion Engine

specified or the order currency

was enabled for strategy execution.

otherwise.

* Calculated if the number of periods is greater than or equal to 3.

ByPeriod Report
The ByPeriod Report shows strategy Performance and Drawdown grouped by time periods. An
example of ByPeriod Report is shown below:

Figure 7. ByPeriod Report

The GUI for ByPeriod Report has three panes:
•

The Chart pane on the left top shows bar chart for selected performance statistic metric.

•

The Parameters pane on the right top shows performance statistic metric details.
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•

The Content pane shows performance statistic metrics grouped by time period.

The next table briefly describes the Content pane columns:
Column

Description

#

Record Number.

Date

Period start time.

Return

Difference between the values of PnL at Period Close of current period and the value
of PnL at Period Close of the previous period.

Return%

Depends on the TotalReinvestMode value of the Report Engine and is calculated as
follows:
Total Reinvest Mode == true: (Current period’s PnL – Previous period’s PnL) /
(Initial Capital + previous period’s PnL)
Total Reinvest Mode == false: (Current period’s PnL – Previous period’s) /
Initial Capital

Drawdown

Drawdown for the entire period – is calculated as the decline in PnL from the historical
peak during the period to the period end.

Drawdown%

Percentagewise drawdown for the entire period – is calculated as the percentage
between the peak and the period end PnL value.

Max Drawdown

The largest drawdown during the period. For this parameter for each PnL decrease
drawdown is calculated as the decline in PnL from the peak to the trough; then
maximum value between these drawdowns is selected.

Max

The same as Max Drawdown expressed in percentage.

Drawdown%

Below follow descriptions of the Parameters pane columns:
Column

Description

Total Periods

Total number of periods during strategy execution time.

Profitable Periods

Number of profitable periods.

Profitable Periods %

Number of profitable periods expressed in percentage relative to total
number of periods.

Avg Return%

Return% Average.

Std.Dev.Return%

Return% Standard Deviation.
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Best Return%

Maximum of Return%.

Worst Return%

Minimum of Return%.

Avg Return

Return Average.

Std.Dev.Return

Return Standard Deviation.

Best Return

Maximum of Return.

Worst Return

Minimum of Return.

Avg Drawdown %

Drawdown% Average.

Std Dev Drawdown %

Drawdown% Standard Deviation.

Worst Drawdown %

Minimum of Drawdown%.

Avg Drawdown

Drawdown Average.

Std Dev Drawdown

Drawdown Standard Deviation.

Worst Drawdown

Minimum of Drawdown.

Max Consec Profitable

Max number of continuous profitable periods.

Max Consec Unprofitable

Max number of continuous unprofitable periods.

ByInstrument Report
The ByInstrument Report contains performance and risk metrics of the strategy execution for each
instrument. An example of ByInstrument Report is shown below:
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Figure 8. ByInstrument Report

For columns descriptions see the description of Performance Report.

Drawdown Report
The Drawdown Report contains strategy execution drawdown daily statistic. An example of
Drawdown Report is shown below:
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Figure 9. Drawdown Report

The GUI for the Drawdown Report has four panes:
•

The Chart pane on the left top shows the chart for selected drawdown statistic.

•

The Continuous pane in the right top shows continuous drawdown details.

•

The Parameters pane in the right bottom shows drawdown aggregate statistics by some
metrics.

•

The Content pane shows drawdown statistics details grouped by trading day.

The Content pane columns:

25

QuantOffice Reporting System

Column

Description

#

Record Number.

Date

Day open time.

Profit

Profit at Day Close time.

Drawdown

The difference between the Profit at day close time and maximal Profit at
day close time up to (and including) the current day.

Drawdown%

Percentage between the Profit at day close time and maximal Profit at day
close time up to (and including) the current day.

The Parameters pane displays the Average and Standard Deviation aggregate statistics for
drawdown metrics being Drawdown, Drawdown% and Duration (days). Duration shows the
number of days covered by a drawdown.

Allocation Report
The Allocation Report shows the portfolio value allocation among instruments. An example of
Allocation Report is shown below:

Figure 10. Allocation Report

The GUI for the Allocation Report has three panes:
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•

The Content pane shows the performance statistics for each instrument. See the section
about Performance Report for columns description.

•

The Chart pane on the right top shows the bar chart for selected performance metrics.

•

The Symbol pane in the right bottom shows the selected performance metric for each
instrument.

Custom Reports
In addition to standard reports, you can create your own custom reports with any necessary data.
A custom report is a kind of log, which will be presented in the form of a table.
The columns of the report and the data displayed in the columns are entirely defined by the user
creating the report. If you have included Report Engine into the strategy you can use strategy
statistics generated by Report Engine in your custom report (see the Accessing Report Properties
and Strategy Statistics in Strategy Code section).

Creating Custom Report
Creating custom report, you create a C# class representing the report.
•

Click New... in the Reports group in the Configuration tab of the Strategy Designer
window.

The Report Properties dialog appears:
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Figure 11. Report Properties

•

In the Name box specify a name for the class, which will represent the report. The name
would comply with the naming conventions for C# classes.

Each row of the Parameters table of the Report Properties dialog represents a column of your
future report. From the other point of view in each row you define a parameter with which the Log
method will be called for the created report class.
•

Navigate to the first row of the Parameters table. Select a type of the parameter in the Type
column.

You choose from the list of value types supported by C#.
•

In line specify the name for the parameter in the Name column.

•

Click Save in the dialog.

•

If necessary, navigate to the next row and add as many rows as you need in the way
described above.
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You may use Move Up (

) and Move Down (

) tool buttons to arrange the defined parameters

in the desired order. In which order the parameters are displayed in the dialog from top to bottom,
in the same order the corresponding report columns will be displayed from left to right.
You can also use the tool buttons provided in the Report Properties dialog to copy report definition
to the clipboard (
definition from a file (

), paste report definition from the clipboard (
) or save the current report definition to a file (

), load an existing report
).

If you have a custom class defined in the strategy code, you can define a report based on this
class. You need to click the Create Report Definition from (

) tool button in the dialog and select

the class from the list in the popped-up dialog. Click OK. In this case the Parameters table will be
filled with the members of the selected class.
•

When all the modifications in the Report Properties dialog are made, click the Save button
in the dialog.

•

Click Close to close the dialog.

For example, let’s make the following specifications in a strategy created by EMA Crossover
Intraday template:

Figure 12. Example report properties
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After you click Save in the dialog, the created report appears in the Reports… group of the
Configuration tab and in the Reports stencils for InstrumentExecutor.cs and PortfolioExecutor.cs
files:

Figure 13. Sample custom report in the Reports group

Figure 14. Sample custom report in the Reports stencil

Inserting Custom Report into Strategy
Once you have created a custom report in the way described above, it appears in the Reports
stencil of Strategy Designer and you can insert it into your code.
•

Open the appropriate file (either InstrumentExecutor.cs or PortfolioExecutor.cs).

•

Drag the report class from the Reports stencil to the proper place of your strategy code.

For example, let’s drag the Position_Change report to the OnPositionChange method of the
InstrumentExecutor class.
Further results depend on the Ask Parameters option of the Options main menu.
If the Options ->Ask Parameters option is not checked, a string like presented below is added to
the report:
Position_Changes.Log("Position_Changes", ? ,?)

In this case, you need to edit the inserted row and replace the question marks with parameters for
the Log method.
If the Options ->Ask Parameters option is checked, the report Arguments dialog appears:
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Figure 15. Report Arguments dialog

•

In the Title box of the dialog specify the title for the report, which will represent it in the tree
of all reports (or in a tab in case of several Log methods).

•

Then for each of the columns specify a value to be presented in the column.

Note that you can specify only constants here. If you need later in the code, you can replace a
constant by a variable.
For example, let’s make the following specifications:

Figure 16. Arguments of the sample report

•

When all the specifications are made, click OK in the dialog.

As a result, Log method applied to the created report class is inserted into the strategy code. The
first parameter of the Log method is the title of the report; the others represent the columns of the
report.
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For the example above the following code is inserted:
Position_Changes.Log("Position_Changes", "", DateTime.Parse("11/28/2019 6:24:56 PM"));

If you are familiar with C#, you could prefer just to type the code yourself. Now you can modify the
inserted code.
For the example above let’s specify CurrentTime for the DateTime parameter. You will receive the
code like presented below:
Position_Changes.Log("Position_Changes", "Position changed", CurrentTime);

If you do not want some input parameters to be displayed in a custom report, you need to add a
custom attribute to this parameter's description:
[DisplayInfo(DisplayName="Days of payment", ShowInReport=false)]
public bool generateReports = true;

Customizing Custom Report
You could replace the Log method with the Log2 method or set the Incremental parameter of the
Log method to True to receive slightly different reports with different provided functionality. The
differences between these reports are detailed in the next section.

Description of Resulted Custom Report
The resulted custom report is a kind of a log. That means that data appear in it little by little as the
strategy is running as against to standard reports, which results all appear after the strategy
execution.
The created report appears in the in the hierarchy of all reports in the Navigator pane of Report
Explorer as presented in the figure below:
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Figure 17. Custom report in the tree of strategy's reports

As it was said above, in the tree the report’s name is the same as the value of the first parameter
(the Title parameter) of the corresponding Log method (in case of several Log methods in the tree
a name of one report is presented, other names appear in tabs displaying appropriate reports in the
Content pane).
If you select the report in the tree, its content is displayed at the right in the Content pane:

33

QuantOffice Reporting System

Figure 18. Custom Report example

The information in the report is logged row by row as the strategy is running.
The first columns of the report are predefined by the parameters with which the corresponding Log
method was called. The next columns contain values of input parameters of the strategy.
The provided toolbar allows you to receive different views of the displayed data and to manipulate
them. Most of the tool buttons are self-explanatory. For descriptions of others, you may refer to the
Working with Reports Explorer (Viewing Reports) section.

Log Custom Report
If the Log method is used for the report creation, the following tool bar is provided for the report:
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Figure 19. Log method toolbar

In this case if the report contains a large amount of data, not all the data are displayed – only the
first portion of data is displayed, the rest of data is available via the Next and the Show All
commands.

Figure 20. Next and Show All commands to display more reported data
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If you need to display all the data in the report, you should set the value of the report class’s
IncrementalUpdate variable to True in the strategy code (you should do this once in the OnInit

method).
If strategy has complex input parameters (like collections), they can be viewed in the Details
dialog, which is displayed if you double click on any row of the report:

Figure 21. Detailed presentation of input parameters

Log2 Custom Report
If the Log2 method is used for the report creation, the following tool bar is provided:

Figure 22. Log2 method toolbar

It provides more enhanced functionality as against to Log method toolbar. All the data are logged
and displayed in this case.
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Several Log Methods
If you use several log methods to create reports on the base of one report class, the created
reports will be displayed in different tabs as in the figure below:

Figure 23. Two reports in different tabs

Working with Reports Explorer (Viewing Reports)
The created reports are viewed in Report Explorer.

What Is Report Explorer?
Report Explorer is QuantOffice Report Engine graphical user interface (GUI). It allows you to:
•

Browse strategy execution reports and charts.

•

Analyze and visualize strategy execution results.
37

QuantOffice Reporting System

•

Consolidate generated reports.

•

Apply different layouts for generated reports.

•

Export reports to various formats.

•

Save reports in persistence repository.

Figure 24. Report Explorer

Report Explorer has three panes:
•

The Navigator pane on the left top shows the hierarchy of generated reports for currently
executing strategy. Reports can be subjected to various parent, child, and sibling
relationships.
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•

The Parameters pane on the left bottom shows strategy execution input parameters.

•

The Content pane shows currently active report details.

Report Explorer Description
Strategy Reports Layout
Strategy Reports (Report Explorer) allows the user to display and analyze the output produced by
execution of strategies. This window appears when the strategy is executed within Strategy
Runner. An example of Strategy Reports (Report Explorer) window is presented in the figure
below:
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Figure 25.Strategy Reports
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The Strategy Reports window contains a menu bar at the top. The rest of the window is occupied
by the workspace area, housing the resulting artifacts. Upon completion of a strategy, the
workspace contains a single tabbed panel by default, captioned Reports. In the rest of this
document, the term Strategy Reports Window will refer to the entire window, while the term
Reports Pane will refer specifically to the tabbed pane.
The output of strategy execution is represented in two forms – as charts and reports. These
documents can be produced in standard form, or they can be customized. This document deals
only with reports description. For details on charts, please refer to the Charting document.
The structure of generated reports can range in complexity from simple tabular reports (e.g. Trades
and Orders reports,) to fairly complex reports (e.g. Drawdown and By Period reports).
Note: The generation of additional charts and reports is optional and must be activated by including
appropriate statements into strategy code.
Most of the Strategy Reports window commands are equally applicable to standard and custom
charts and reports. Certain commands are reserved for standard or custom artifacts.

Tabbed and Internal Windows in Strategy Reports
By default, upon the completion of a strategy, the workspace contains a single tabbed panel. This
panel shows only one document at a time.
If desired, it is possible to show resulting artifacts in multiple tabs, all within the same Strategy
Reports window.
The easiest way to display a resulting artifact in a separate tab is to right-click the document title
and select the Tab command in the Navigator popup menu (see the figure below):
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Figure 26. Displaying Separate Tab

The selected artifact will be excluded from the list and will appear in a separate tabbed panel:
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Figure 27. Trades in a Separate Tab

Figure 28. Updated List of Artifacts
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Every tab has a cross icon to its right, to close the active tab.
Closing a tab with the cross icon does not return the document into the original list. Therefore, once
a separate tab is closed, its contents cannot be viewed again, unless it is re-generated by rerunning the strategy.
In order to close a tab while returning the document to the original list, right-click the tab and
choose the UnTab command from the pop-up menu.

Figure 29. The UnTab Command

Main Menu of Strategy Reports Window
The menu bar of the Strategy Reports window can be found at the top of the window. It contains
two menus: File and Window.

File Menu
The File menu item contains several commands:
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Figure 30. The File Menu

Save Configuration saves the existing configuration or allows you to name it if the configuration
does not have a name. The new configuration name will be displayed at the top of the Strategy
Reports window next to the strategy name. The existing configuration can be renamed anytime by
the Save Configuration As... command. The Close command will close the Strategy Reports
window, including all open documents.

Window Menu
The Window menu contains several commands to change the layout of the child windows of the
Strategy Reports window (Cascade, Tile Horizontally and Tile Vertically), as well as a list of
currently open child windows.

Figure 31. Window menu

45

QuantOffice Reporting System

Window layout configuration is a standard feature of the Microsoft Windows operating system.
These commands are enabled only when there are open child windows. An example of the Tile
Horizontally command for four child windows is shown below:

Figure 32. Tabbed and Tiled Panes

Displaying several reports simultaneously may be very effective in analyzing the behavior of a
strategy under different conditions: by comparing same-type reports produced in the course of
several runs, by comparing different reports from the same run, or by conducting a detailed multifactorial analysis of strategy performance.

Navigator Pane
The Navigator pane can be found at the top left of the window. This pane is used for selecting a
document for display. The Navigator pane contains a list of all results generated after running a
strategy, grouped into three areas: Charts, Reports and Consolidated Reports.
The exact contents of the Navigator pane depend on the type of output generated by the strategy
code.
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Figure 33. Navigator Pane

Node Structure
Every node in the tree contains a selection check box, an icon representing the output type, the
experiment number starting with the # sign, except for consolidated reports, and a node name.
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Figure 34. Artifact Node Structure

Standard reports have built-in names. Custom report names can be assigned by the strategy
developer.

Additional Grouping of Nodes
Inside the top-level groups (Charts, Reports and Consolidated Reports), nodes can further be
grouped, by experiment number, output type, or both. The grouping is controlled in the Settings
dialog invoked by clicking the Edit Settings (

) tool button.
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Navigator Pane Toolbar
Navigator contains a toolbar at the top. Most toolbar commands can also be found in pop-up
menus, activated by right-clicking in the panes.
The Navigator pane toolbar commands control the output as a whole.

Figure 35. Navigation Pane Toolbar

The following table describes operations available in the Navigator pane’s toolbar:
Button

Description
The Save To Repository button.
Saves the selected items in the form of .csv (comma separated values) files for
subsequent processing, for example, in MS Excel.
The location of the repository folder can be set in the Settings dialog, if it has not yet
been set in the Instrument Strategy Runner Settings dialog at the time of starting the
strategy.
The reports to be saved are selected in the Select Runs dialog, which appears next:
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The Save Strategy Parameters button.
Saves strategy parameters in a designated location as an XML file, like the Save function
in Input Parameters.
The Edit Settings button.
Displays the Settings dialog, where you can specify the grouping of reports, as discussed
before:

The Make Window Tabbed button.
Opens the artifact, currently selected in the Navigator pane, in a separate tabbed pane.
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The Apply Settings to All Similar Items button.
Propagates settings from one chart to all other charts of the same type. For example, if a
chart of one financial instrument has a specified time range, this action will cause charts
of all securities to be configured with the same time range. (the button refers to charting
and doesn’t touch reports).
The Delete button.
Removes items selected by checkboxes in the navigation tree.
The Export button.
This button opens a drop-down list with commands for exporting the selected documents
to either MS Excel or Adobe Acrobat file format.

Use check boxes to the left of nodes to select documents for export:
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The Consolidate button (available in report mode only).
Creates a consolidated report during the analysis phase, i.e. after the strategy has been
run. Consolidate contains two sub-actions:

The Checked Reports command applies only to custom reports. It is grayed out for
standard reports.
The By Report Type command creates consolidated reports for all applicable report
types. This command opens the Consolidated Reports Options dialog, which allows
selecting the Input Parameter columns for report generation, as well as the types of
Reports subject to consolidation.
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Parameters Pane
The Parameters pane is located at the bottom left of the window. This pane displays the
parameters used to run the strategy. If multiple experiments have been run, the Parameters pane
specifically shows the parameters of the experiment that generated the artifact currently selected in
the Navigator pane.

Figure 36. The Parameters pane

You can also edit the visible parameters by clicking the Customize

button, also shown in the

figure above. You can use the Customize dialog that pops up (see the figure below) to turn off/on
visible parameters. It is a useful function to reduce overcrowding, particularly if you have numerous
parameters in a strategy run.
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Figure 37. The Customize dialog

Next to the Customize button you can find the Compare button

which is used to compare input

parameters from several consecutive experiments, or from different runs of one experiment:

Figure 38. Compare Input Parameters
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In the upper right corner of the Parameters pane, you can find the Maximize button (

) which

expands the Parameters pane. You can restore the pane to the previous size using the Minimize
button ( ).

Content Pane
The Content pane is located on the right of the Strategy Reports window. It displays the
document that is currently selected in the Navigator pane. An example of Content pane is
presented in the figure below:

Figure 39. The Content Pane Displaying a Report

Work with the data in the Content Pane is provided by its toolbar. The Reporting toolbar appears at
the top of the reporting pane and varies depending on the type of reports.
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Figure 40. Content Pane Toolbar in Report View Mode

Most of the tool buttons are self-explanatory. Some are described below in detail.

Setup Columns in Content Pane
The Setup Columns (

) button displays the Columns Setup dialog. In this dialog you

can configure the columns displayed in the report.

Figure 41. Setting up Report Columns

This dialog allows the configuration of a wide variety of column options. You can customize the
column name, alias, format by simply clicking on the desired location and editing the names or the
formats.
The user is not limited to the list of columns shown. To add new columns, click New in the toolbar.
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Figure 42. Setting up New Columns

As an example, you can click New -> Total Column to introduce a new column that adds items
within a designated column. Edit the Expression Builder dialog that pops up (see the figure below)
with the desired expression to create your totals column. When you click OK, your new column will
be included into the report.

Figure 43. The Expression Builder dialog
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The Price column allows ticking the columns that contain price data to enable price display format
for the report. If you have fractional prices format specified in TimeBase, enabling price format
allows to display prices in fractional format in the report columns.
You can use the Scale and SubTotal function in the Columns Setup for customizing grouping for
your reports.
As a simple example, if you would like to group your columns in quartile percentages based on net
profit, and then by maximum CAGR (compound annual growth rate) within each subsegment:
You would first create a scale for Net Profit Column by clicking Add... in the Scale column for Net
Profit in the Columns Setup dialog.

Figure 44. Creating scale for a report column

Change the interval to 4 in the scale to designate quartiles. Next step would be to create a
SubTotal for the CAGR column by clicking Edit ( ) in the empty box under SubTotal,
corresponding to the CAGR column. The following box will appear:
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Figure 45. Defining SubTotals Parameters

Pick the Max option and click OK to create a maximum CAGR grouping for your column.
Now you can close the Columns Setup dialog. Finally, click on the Group By (

) button in

the toolbar to first group results by our Total Profit, then by CAGR.

Figure 46. The Group By Dialog

After you click OK, you will see a report that looks like the following:
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Figure 47. Customized Reports

Notice that the final report shows the Maximum CAGR within each quartile. This particular custom
report is ready for further analysis by clicking on any desired section.
You can also introduce freezing and coloring to your columns by checking those options in the
Columns Setup dialog.
Freezing a column essentially fixes that particular column and allows user to scroll horizontally
while keeping the selected column fixed. You can also introduce coloring to a column by checking
the Coloring option in the dialog and specifying a color in the Scheme column.
You can also open a simplified form of the Columns Setup dialog to control just column visibility
and display formats by selecting the Setup Columns -> Display Styles command:

Figure 48. Setup Columns -> Display Styles

A simplified version of the Column Styles dialog will be displayed:
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Figure 49. Column Styles

You can select columns to be displayed and specify their formats. Click OK when finished.
By using the Setup Columns -> Import Data command, you can import columns from external
sources.
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Figure 50. Import External Columns

Filtering in Reports
QuantOffice allows the filtering of data in reports. To use this feature, make sure the filtering criteria
row in the report is displayed by clicking the Enable Filter (

) button. This special row is located

under the report header and contains filtering criteria for individual columns.

Figure 51. Filtering Criteria Row

To define filtering criteria for a specific column, click the filtering criteria cell above that column.
Edit Filter dialog will be displayed. The content of this dialog depends on the column type.
For example, Edit Filter for the Instrument column of the Trades report allows including or
excluding selected financial instruments:
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Figure 52. Edit Filter for Instrument Column of Trades Report

The Edit Filter dialog for the Type column in the By Instrument report allows including or
excluding trades based on specified categories (Long Trades / Short Trades / All Trades):

Figure 53. Edit Filter for Type Column of By-Instrument Report

You can enable and disable filters in each report by selecting these filters and specifying their
conditions in the Setup Filters dialog.
Click the

button to display this dialog for the currently selected report.

For example, the Setup Filters dialog for Trades report is presented below:
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Figure 54. Setup Filters for Trades Report

If you select a check box for a column or specify a Filter Expression by clicking the

button, the

appropriate Edit Filter dialog is displayed.
You can use Edit Group Filters (

) to filter within an established group. The following box, for

instance, would introduce a Net Profit/Loss filter of only profitable instruments up to $30,000 for our
scale example from the previous Setup Columns section.

Figure 55. Edit Group Filters
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View Data Chart Option
To use the View Data Chart option in the custom report, click on the Charts (

) button in the

toolbar. This will invoke the following dialog:

Figure 56. Chart

This dialog allows you to specify parameters for charting. For more details, refer to the Charting
document.

Go to Chart Option
To use the Go To Chart option in the custom report, click on one of the rows and select the Charts
-> Go To Chart command.
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Figure 57. Go To Chart in the toolbar

This will invoke the following dialog:

Figure 58. The Go To Chart dialog

This option will bring you to the target chart for the DateTime and symbol, corresponding to the
selected record in the Custom report.

Report Pop-Up Menu and Report Header Pop-Up Menu
In addition to common toolbar functions, every report has a Report Pop-Up Menu applicable to its
data rows, and a Report Header Pop-Up Menu applicable to its columns.

Report Pop-Up Menu
To display the Report Pop-Up Menu, right-click a report row:
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Figure 59. Report Pop-Up Menu

Report Header Pop-Up Menu
To display the Report Header Pop-Up Menu, right-click in the appropriate header column:

Figure 60. Report Header Pop-Up Menu

Viewing Histogram for Report
For report data you can create a histogram.
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A histogram is a graphical representation showing a visual impression of the distribution of data.
The X-axis represents the range of available values – it is split into a number of intervals. Adjacent
rectangles erect over the discrete intervals. The height of each rectangle (along Y-axis) is equal
either to number of points found in the interval or to the frequency of points hit into the interval.
Open the desired report and click the View Histogram (

) tool button at its toolbar in the Content

Pane.
New histogram item appears in the Navigator pane. The histogram opens in the Content Pane at
the right. In the Content Pane you see distribution of values of each report column in a separate
tab.
Note: X-axis values are displayed at the slide bar under the histogram.
The figure below presents an example of a histogram for the Net Profit/Loss column of the
ByInstrument Report:

Figure 61. Histogram
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Click the tab presenting the column report, for which histogram you want to view.
If rows were grouped in the parent report, you will be able to select only from the Total or
SubTotals variables defined in the report.
Also, if rows were grouped in the parent report, you can choose data for which groups to display:
In this case click the Groups… tool button and in the displayed dialog check the groups to be
presented.
What concerns the histogram, further in the Intervals box specify the number of intervals you
would like to divide the range of values into. As it was said above, the intervals will be put along X
axis.
In the Type box specify either you want to represent Frequency or Number by the height of the
histogram bars.
The table below provides descriptions of Histogram tool bar, which allows you to tune the
representation to your needs and requirements:
Button/Field

Description
The number of intervals you would like to divide the range of values into. As it was said
above, the intervals will be put along X-axis. Each histogram bar will be erected over a
separate interval.
Specifies which will be represented by Y-axis values (height of the bars).
Number of points hits into an interval or a frequency of the points hits.
If you want to use logarithmic scale for Y-axis, toggle this button on. When logarithmic
scale is on, specify the minimum value on the Y-axis by the number in the combo box.
Is used when rows in the parent report are grouped. Displays the Specifying
Groups… dialog allowing you to check data on which groups to display at the
histogram.
If the box is checked, cumulative diagram will be built.
Shows or hides Normal distribution curve at the same axis where histogram is
displayed.
Shows or hides the difference of the histogram values with Normal distribution curve at
the same axis where histogram is displayed.
Allows to specify printing settings and to print the histogram.
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Shows or hides the report data at the bottom of the histogram.
Displays or hides the log.

Now let’s consider which data are displayed at the right of the histogram.
The Filter group of controls allows you to specify range of values to be displayed for the X-axis and
for the Y-axis.
The Minimum and Maximum fields allow you to specify the range of values, which distribution will
be represented at the histogram. For the specified minimum and maximum click the From
Selection link.
Another way to change the range of values is to select the desired range with red triangles under
the histogram and click the From Selection link.
The Create Filter link discharges all your settings and displays the default histogram.
The Sigma Limits link allows you to apply 3-sigma or 6-sigma limits algorithm to the histogram
cutting the range of the X values.
The Statistics box displays the following information:
•

Minimum – the beginning of the interval of distributed values.

•

Maximum – the end of the interval of distributed values.

•

Number of values – total number of distributed values which are taken into account for
default histogram. Actually, it is the number of rows in the parent report.

•

Visible values – number of values taken into account for currently visible diagram. For
example, it is different from the Number of values if you changed the minimum and
maximum values.

•

MEAN – the mean for the displayed values – standard average” which is calculated as the
sum of the values divided by the number of values.

•

ST DEV – standard deviation for the displayed values, which shows how much variation
exists form the average (mean).

•

MEDIAN – median for the displayed values – the middlemost number in the set of values. It
divides the range of values into two parts so that equally the half of values occurs in each of
the parts.

The Details box displays a table with detailed figures of the histogram.
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Viewing Scatter Plot for Report
For report data you can create a scatter plot.
A scatter plot shows the relationship between values of two specified report columns by displaying
data points ( ) on a two-dimensional graph.
Open the desired report and click the View Scatter Plot (

) tool button at its toolbar in the

Content Pane.
New scatter plot item appears in the Navigator pane. The scatter plot opens in the Content Pane to
the right.
The figure below presents an example of a scatter plot for Trades Report:

Figure 62. Scatter Plot

71

QuantOffice Reporting System

In the drop-down lists at the top of the window select which variable versus which will be displayed
in the scatter plot:

Figure 63. Choosing which variables to plot

In the first drop-down select the variable which values will be plotted along the X-axis, in the second
drop-down select the variable which values will be plotted along the Y-axis.
If rows were grouped in the parent report, you will be able to select only from the Total or
SubTotals variables defined in the report.
Also, if rows were grouped in the parent report, you can choose data for which groups to display:
In this case click the Groups… tool button and in the displayed dialog check the groups to be
presented.
What concerns the scatter plot, you are provided with the possibility to display or hide a regression
line for points visible at it. The regression line is the straight line of best fit calculated using the least
squares method for all the points presented in scatter plot.
Check the Regression (

) option to display the linear regression line for the presented

points.
If you want to display the report data at the bottom of the scatter plot, click the View Details (
) button.
You can select points at the scatter plot. They will be selected in the report details displayed at the
bottom of the window (if they are displayed) and in the Details box at the right of the scatter plot.
To select a point at the plot:
•

Just click over it.

•

Use “Shift” key to add items to the selection. Use “Ctrl” key to exclude items from the
selection.

From the other hand, if you select rows in the report, details displayed at the bottom of the window.
Corresponding points will be selected ( ) at the scatter plot.
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If scaling is defined for the parent report, you can display points belonging to different scaling
intervals with different colors. For this purpose, click the arrow at the Coloring drop-down box at
the top and select a column which scaling you want to represent at the scatter plot with different
colors.
At this, random different colors will be used.
Now let’s consider which data are displayed at the right of the scatter plot.
The Filter group of boxes allows you to specify range of values to be displayed for the X axis and
for the Y axis.
The Statistics box displays the following information:
•

Number of values – total number of values in the data set.

•

Visible values – number of values currently visible on the plot.

•

A, B, R2 – result of calculation of Simple Linear Regression, which is presented by the
equation y =  + x, where
A, B –  and  regression coefficients.
2

R2 – R , coefficient of determination of linear regression.
The Details box displays a table with values of all the points of the scatter plot.
The Visible box shows either the point is displayed at the plot or not (note that you manage
visibility of points via Filter).
If you select a point in the Details box, it will be selected at the plot and look as follows ( ).

Viewing Bar Chart for Report
For report data you can create a bar chart. A bar chart is a chart with rectangular vertical bars with
lengths proportional to the values that they represent. Bars represent values of a report column;
each bar stays for a row of the report.
Open the desired report and click the View Bar Chart (

) tool button at its toolbar in the Content

Pane.
New bar chart item appears in the Navigator pane in the Custom Reports folder; the bar chart
opens in the Content Pane at the right.
The figure below presents an example of a bar chart for Trades Report:
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Figure 64. Bar Chart

In the drop-down lists at the top of the window select which variable you want to represent by the
bars of the chart.
The figure in the example above represents Net Profit.
If the rows in the parent report were grouped, then you will be able to select only from the defined
Total and SubTotals values. Each bar will appropriately represent the selected value for a group.
There exist several ways for changing the scale at the bar chart:
•

Use

•

Click the arrow at the axis you want to change the scale for and select the desired scale

/

buttons to zoom in/out the scale of X-axis.

from the list:
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Figure 65. Setting scale for Y-axis

If you want to use logarithmic scale for Y-axis, toggle the

button on. If logarithmic

scale is on, specify the minimum value on the Y-axis by the number in the combo box.
,

and

buttons are used when data in the parent report are grouped by two or more

columns (at least two-level grouping is used).
The

button allows to move to one level downward and to show group content on the chart.

The

button allows you to move back to on level upwards after moving downwards has been

made.
Clicking the

button draws bars stacked or vice versa returns to the non-stacked version.

The figure below displays stacked and not stacked representation:
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Figure 66. Example of stacked and not stacked bars

Export Report Data to Excel or to Text
You are provided with the possibility to export report data to Excel file or to Comma Delimited text
file.
Click the Export to Microsoft Office Excel (

) tool button in the report.

The Report Type dialog looking like the figure below appears:

Figure 67. The Report Type dialog
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Check Microsoft Office Excel, if you want to export data to MS Excel file.
If data in the report is grouped, you have the following options to select:
•

List of groups only.

•

Show group content in separate worksheets.

•

Taxonomy (exports names of groups preserving hierarchy of groups).

Check Comma Delimited Text File, if you want to export data to text file.
Click OK in the dialog.
Either the report is created in MS Excel or the Specify Report Columns dialog looking like the
figure below appears:

Figure 68. Specify Report Columns dialog
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Check the columns which data you intend to export and click OK.

Portfolio Browser Overview
In case your strategy contains portfolio orders, you are able to use special feature that helps
viewing your strategy statistics. It is very useful when you need to analyze statistics within one
portfolio or subportfolio.
Portfolio Browser button will appear in Allocation, ByPeriod and Drawdown reports, and also in
the Performance report switched to table mode. Portfolio View button will be available on the
toolbar of ByInstrument report, and you will also notice Portfolio filter in Allocation, Drawdown
and ByPeriod reports.
Click the Portfolio Browser button to invoke the Portfolio Browser window, which will be displayed
on the right side of your report. Portfolio Browser in Allocation report is shown below:

Figure 69. Portfolio Browser in Allocation report

You can see that Portfolio Browser displays all portfolios and subportfolios your strategy contains.
In the example strategy contains two portfolios, and each of them contains three subportfolios.
Select the desired portfolio or subportfolio in Portfolio Browser window to observe statistics of your
strategy within this subportfolio:
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Figure 70. Net Profit/Loss for portfolio

You will also notice that the selected subportfolio hierarchy will be displayed in Portfolio filter on the
toolbar. You can also choose directly in this filter the desired portfolio to display:

Figure 71. Portfolio filter on the toolbar of the report
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Similarly, you can apply filtering by portfolio in ByPeriod and Drawdown reports:

Figure 72. Portfolio Browser in ByPeriod report

Figure 73. Portfolio Browser in Drawdown report

For example, in Figure 72 you can observe Return for all positions in Information Technology of
XNYS.
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To show Portfolio Browser in Performance report, navigate to this report and click the Switch to
Table View button:

Figure 74. Portfolio Browser in table mode of Performance report

As for ByInstrument report, it is available to apply Portfolio View for analyzing. Click the Portfolio
View button in the toolbar of the report and your trades will be grouped by portfolios:

Figure 75. Portfolio View in ByInstrument report
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About Built-in Reports for Advanced Users
This section contains information that you will not probably use if you are new to QuantOffice. This
section tells about working with strategy code related to reporting. Most of the described
possibilities are also available via interface commands and are used via interface commands. This
includes code added when you insert Report Engine and reports, customizations you can make in
using standard reports and some other advanced features.

Code Added for Report Engine and Reports
This chapter will tell you how to add Report Engine and standard reports manually adding code into
the strategy.
It also can be referred to learn which code is added to the strategy when the Add Component ->
Report Engine… command is activated.

Creating Report Engine
The example below shows how to create and initialize Report Engine in a strategy manually.
Note: Report Engine requires Order Processor component to be included into the strategy code.
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1. Report Engine library (Reporting.dll) is added to the strategy’s Libraries group.

Figure 76. Added Report Engine library

2. Modifying the PortfolioExecutor.cs file:
a) Add the following using directives:
using QuantOffice.Reporting.Model;
using QuantOffice.Reporting.API;

b) Declare local variable reportEngine in Local Variables region:
#region LocalVariables
internal OrderProcessor orderExecutor;
[NonRendered]
public ReportEngine reportEngine = null;
#endregion
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Note that the OrderProcessor variable is not added automatically with the Report Engine
component (for OrderProcessor component addition, please, refer to Strategy Designer document).
c) Report Engine object is created, its parameters are initialized and Start is called in the
OnInit method:
public override void OnInit()
{
reportEngine = new ReportEngine(this, orderExecutor, orderExecutor);
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Mar = 0.0;
reportEngine.FundingCurrency = "USD";
reportEngine.TradeReport.Enable();
reportEngine.OrderReport.Enable();
reportEngine.ExecutionReport.Enable();
reportEngine.PerformanceReport.Enable();
reportEngine.ByInstrumentReport.Enable();
reportEngine.ByPeriodReport.Enable();
reportEngine.DrawdownReport.Enable();
reportEngine.AllocationReport.Enable();
reportEngine.Start();
//Call Instruments OnInit
base.OnInit();
}

Note that it is recommended to initialize and set Report Engine parameters before calling its Start
method.
d) Report Engine Finish is called in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.TradeReport.Show();
reportEngine.OrderReport.Show();
reportEngine.ExecutionReport.Show();
reportEngine.PerformanceReport.Show();
reportEngine.PerformanceReport.Consolidate();
reportEngine.ByInstrumentReport.Show();
reportEngine.ByInstrumentReport.Consolidate();
reportEngine.ByPeriodReport.Show();
reportEngine.DrawdownReport.Show();
reportEngine.AllocationReport.Show();
//Call Instruments OnExit
base.OnExit(exitState);
}
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Trades Report Code
The Trades Report contains the entire list of trades taken by the strategy during execution.
For adding Trades Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. Trades Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.TradeReport.Enable();
reportEngine.Start();
}

b. Trades Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.TradeReport.Show();
}

After strategy finishes, the Report Explorer will display the Trades Report.

Orders Report Code
The Orders Report contains the entire list of orders taken by the strategy during execution. For
adding Orders Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. Orders Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.OrderReport.Enable();
reportEngine.Start();
}
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b. Orders Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.OrderReport.Show();
}

After the strategy finishes, the Report Explorer will display the Orders Report.

Executions Report Code
The Executions Report contains the entire list of executions taken by the strategy during execution.
For adding Executions Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. Executions Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.ExecutionReport.Enable();
reportEngine.Start();
}

b. Executions Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.ExecutionReport.Show();
}

After the strategy finishes, the Report Explorer will display the Executions Report.

Performance Report Code
The Performance Report contains the performance metrics of strategy execution. For adding the
Performance Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.
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•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. Performance Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.PerformanceReport.Enable();
reportEngine.Start();
}

b. Performance Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.PerformanceReport.Show();
}

After the strategy finishes, the Report Explorer will display the Performance Report.

ByPeriod Report Code
The ByPeriod Report shows strategy Performance and Drawdown grouped by time period. For
adding ByPeriod Report to the strategy the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. ByPeriod Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.ByPeriodReport.Enable();
reportEngine.Start();
}

b. ByPeriod Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.ByPeriodReport.Show();
}

After the strategy finishes, the Report Explorer will display the ByPeriod Report.
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ByInstrument Report Code
The ByInstrument Report contains performance and risk metrics of the strategy execution for each
instrument. For adding the ByInstrument Report to the strategy the following modifications should
be made in the PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. ByInstrument Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.ByInstrumentReport.Enable();
reportEngine.Start();
}

b. ByInstrument Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.ByInstrumentReport.Show();
}

After the strategy finishes, the Report Explorer will display the ByInstrument Report.

Drawdown Report Code
The Drawdown Report contains the strategy execution drawdown daily statistic. For adding
Drawdown Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•
•
•

Report Engine is included into the strategy.
Order Processor component is included into the strategy.
Report Engine InitialCapital parameter is specified and is greater than 0.

a. Drawdown Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.DrawdownReport.Enable();
reportEngine.Start();
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}

b. Drawdown Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.DrawdownReport.Show();
}

After the strategy finishes, the Report Explorer will display the Drawdown Report.

Allocation Report Code
The Allocation Report shows the portfolio value allocation among instruments. For adding
Allocation Report to the strategy, the following modifications should be made in the
PortfolioExecutor.cs file provided that:
•

Report Engine is included into the strategy.

•

Order Processor component is included into the strategy.

•

Report Engine InitialCapital parameter is specified and is greater than 0.

a. Allocation Report should be enabled in the OnInit method:
public override void OnInit()
{
reportEngine.AllocationReport.Enable();
reportEngine.Start();
}

b. Allocation Report should be shown in the OnExit method:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.AllocationReport.Show();
}

After the strategy finishes, the Report Explorer will display the Allocation Report.

Customizations in Using Standard Reports
The QuantOffice Report Engine allows you to specify various options when generating reports.
This section deals with changes you can make in the strategy code to tune the reports to your
needs.
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Note that you are also provided with a variety of interface options (including adding calculated
column, grouping and adding total column, scaling, filtering, setting up columns etc.) allowing you to
view the report in a manner you like.

Adding Conversion Engine
The Conversion Engine component allows converting instrument traded currency into a funding
currency in ReportEngine. ReportEngine with plugged in Conversion Engine converts PnL into
funding currency on day close.
To add conversion engine, ensure that Report Engine is included into the strategy and:
a. Declare local variable converter in Local Variables region:
#region LocalVariables
public ConversionEngine converter;
#endregion

b. Create the Conversion Engine object, initialize its parameters and pass it to Report Engine
into the OnInit method. Simulation mode must be set the same as your strategy simulation
mode (DailyBar in this example):
public override void OnInit()
{
converter = new ConversionEngine(this);
ConversionEngineParams cep = new ConversionEngineParams();
cep.AddCrossRate("EUR", "USD", "EURUSD BGN Curncy", false);
cep.SimulationMode = SimulationMode.DailyBar;
cep.CrossCurrency = "USD";
converter.SetParams(cep);
reportEngine.ConversionEngine = converter;
}

Note: Passing conversion engine parameters the same as definition of other properties of
ReportEngine are recommended to be done before calling
reportEngine.Start();

Setting Report Time Zone to Exchange Time Zone
Trades, Orders and Execution reports data can be displayed in Exchange time zone instead of
Local time zone.
a. Modify the OnInit method in PortfolioExecutor.cs:
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public override void OnInit()
{
reportEngine.TradeReport.TimeZone = TimeZoneType.Exchange;
reportEngine.OrderReport.TimeZone = TimeZoneType.Exchange;
reportEngine.ExecutionReport.TimeZone = TimeZoneType.Exchange;
}

Adding Custom Columns to Trade Reports
Trade Report custom column(s) can be added programmatically using Report Engine API in the
way described below:
a. Modify the OnInit method in PortfolioExecutor.cs:
public override void OnInit()
{
reportEngine.TradeReport.AddField("Volatility", typeof(float));
reportEngine.TradeReport.AddField("Comment", typeof(string));
reportEngine.TradeReport.OnTradeEntry += OnTradeEntry;
reportEngine.TradeReport.OnTradeExit += OnTradeExit;
}

b. Add event handlers for OnTradeEntry and OnTradeExit events in PortfolioExecutor.cs:
void OnTradeEntry(object sender, TradeEventArgs e)
{
TradeReport tradeReport = (TradeReport)sender;
tradeReport.SetField(e.Trade, "Volatility", 100.0f);
}
void OnTradeExit(object sender, TradeEventArgs e)
{
TradeReport tradeReport = (TradeReport)sender;
tradeReport.SetField(e.Trade, "Comment", "my comment");
}

Note that you can add custom calculated column to a report by applying a layout to a given report.

Applying Layout
This feature within ReportEngine allows the user to customize the default look and feel of a report.
Layout specifies formatting and display settings for reports and is stored in XML file format.
The example below shows how to save and apply layout for Trades Report:
a. Run strategy and create Trades Report in strategy code.
b. Activate Trades Report in Report Explorer.
c. Modify report layout. For example, group all trades by Trade Type (Long or Short):
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Figure 77. Applying Layout

d. Save report layout to a file on disk. Use the Layout -> Save command on the report toolbar:

Figure 78. Saving Layout

Let’s suppose the layout is saved in the file "c:\my documents\Layouts\TradesReport.palay".
e. Modify the OnExit method in PortfolioExecutor.cs:

public override void OnExit(ExitState exitState)
{
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
string layoutFile = @"c:\my documents\Layouts\TradesReport.palay";
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reportEngine.TradeReport.ApplyLayout(path);
}

Autosize Report Columns
When AutoSize columns property is turned on, the report form measures every cell in each column,
taking into account the cell contents and style and sets columns width to fit the largest cell content.
By default, AutoSize feature is turned off. To enable the Auto size columns feature for a given
report set the AutoSizeColumns property to true.
The example below shows how to auto size columns for Trades Report.
a. Modify the OnExit method in PortfolioExecutor.cs:
public override void OnExit(ExitState exitState)
{
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
reportEngine.TradeReport.AutoSizeColumns = true;
}

Setting ReportDate Property in ByPeriod and Drawdown Reports
The ReportDate property in ByPeriod and Drawdown reports is set to PeriodStart by default.
Therefore, the Date column of this reports contains StartDate property. If you want this column to
display EndDate, ReportDate property should be defined as PeriodEnd:
public override void OnExit(ExitState exitState)
{
reportEngine.Finish();
reportEngine.ByPeriodReport.Show();
reportEngine.ByPeriodReport.ReportDate = ReportDateType.PeriodEnd;
reportEngine.DrawdownReport.Show();
reportEngine.DrawdownReport.ReportDate = ReportDateType.PeriodEnd;
}

Using Advanced Features
Generating CSV File
QuantOffice Report Engine allows generating reports into CSV files (*.csv). This option is available
for Trades, Orders, Executions, ByInstrument Reports and for consolidated Performance and
ByInstrument Reports.
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The example below shows how to generate CSV files (*.csv) for Trades Report and consolidated
Performance Report:
a. Modify the OnExit method in PortfolioExecutor.cs:
public override void OnExit(ExitState exitState)
{
// Setting Report Engine Initial Capital and Risk Free Rate.
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
reportEngine.PerformanceReport.Show();
string path = @"c:\my documents\TradeReport.csv";
reportEngine.TradeReport.SaveToDelimitedFile(path);
string path1 = @"c:\my documents\PerformanceReport.csv";
reportEngine.PerformanceReport.ConsolidateToDelimitedFile(path1);
}

Generating Scatter Plots
QuantOffice Report Engine allows the generation of scatter plots for Trades, Orders, Executions,
ByInstrument, consolidated Performance and ByInstrument Reports.
The following example illustrates creation of scatter plot for Trades Report:
a. Modify the OnExit method in PortfolioExecutor.cs:
public override void OnExit(ExitState exitState)
{
// Setting Report Engine Initial Capital and Risk Free Rate.
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
string layoutFile = @"c:\my documents\Layouts\ScatterPlot.palay";
reportEngine.TradeReport.ApplyLayout(layoutFile);
reportEngine.TradeReport.ShowScatterPlot("Scatter Plot", false);
}
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Scatter plot item will be added to Report Explorer navigator pane and you will be able to view the
scatter plot for trades report:

Figure 79. Scatter plot view

Creating Bar Chart
QuantOffice Report Engine allows the generation of bar chart for Trades, Orders, Executions,
ByInstrument, consolidated Performance and ByInstrument Reports.
The following example shows creation of bar chart for Trades Report:
a. Modify the OnExit method in PortfolioExecutor.cs:
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public override void OnExit(ExitState exitState)
{
// Setting Report Engine Initial Capital and Risk Free Rate.
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
string layoutFile = @"c:\my documents\Layouts\HalfHourProfitable.palay";
reportEngine.TradeReport.ApplyLayout(layoutFile);
reportEngine.TradeReport.ShowBarChart("Half Hour Profitable", false);
}

Report Explorer will display bar chart view:

Figure 80. Bar chart view

Creating Histogram
QuantOffice Report Engine allows the generation of histograms for Trades, Orders, Executions,
ByInstrument, consolidated Performance and ByInstrument Reports.
The following example shows creation of histogram for Trades Report:
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a. Modify the OnExit method in PortfolioExecutor.cs:
public override void OnExit(ExitState exitState)
{
// Setting Report Engine Initial Capital and Risk Free Rate.
reportEngine.InitialCapital = 1000000;
reportEngine.RiskFreeRate = 5.0;
reportEngine.Finish();
reportEngine.TradeReport.Show();
string layoutFile = @"c:\my documents\Layouts\HalfHourProfitable.palay";
reportEngine.TradeReport.ApplyLayout(layoutFile);
reportEngine.TradeReport.ShowHistogram("Half Hour Profitable", false);
}

Report Explorer will display histogram view:

Figure 81. Histogram view

Accessing Report Properties and Strategy Statistics in Strategy Code
As it was said above, Report Engine is intended for collection of strategy statistics. This statistics by
default is used in various standard reports.
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Using the Report Engine API, you can access the performance statistics of the Performance and
ByInstrument Reports and use the data in your own calculations.
For the list of available performance statistics see description of Performance Report.
Modify the OnExit method in PortfolioExecutor.cs:
public override void OnExit(ExitState exitState)
{
// Accessing performance statistics for all trades:
double pnl=reportEngine.PerformanceReport[TradeType.All].TotalProfitLoss;
double r=reportEngine.PerformanceReport[TradeType.All].SharpeRatio;
// Accessing performance statistics for Long trades:
double pnlL=reportEngine.PerformanceReport[TradeType.Long].TotalProfitLoss;
double rL=reportEngine.PerformanceReport[TradeType.Long].SharpeRatio;
// Accessing performance statistics for Long trades:
double pnlS=reportEngine.PerformanceReport[TradeType.Short].TotalProfitLoss;
double rS=reportEngine.PerformanceReport[TradeType.Short].SharpeRatio;
// Accessing performance statistics for the specified symbol:
string symbol = "GOOG";
// Accessing performance statistics for all trades for specified symbol:
double pnl=reportEngine.ByInstrumentReport[TradeType.All, symbol].TotalProfitLoss;
double r=reportEngine.ByInstrumentReport[TradeType.All, symbol].SharpeRatio;
// Accessing performance statistics for Long trades for specified symbol:
double pnlL=reportEngine.ByInstrumentReport[TradeType.Long, symbol].TotalProfitLoss;
double rL=reportEngine.ByInstrumentReport[TradeType.Long, symbol].SharpeRatio;
// Accessing performance statistics for Short trades for specified symbol:
double pnlS=reportEngine.ByInstrumentReport[TradeType.Short, symbol].TotalProfitLoss;
double rS=reportEngine.ByInstrumentReport[TradeType.Short, symbol].SharpeRatio;
}
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